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Preface
Welcome to the Hyperion Analyzer Installation Guide for Windows. This preface 
discusses the following topics:

● “Purpose” on page vii

● “Audience” on page vii

● “Document Structure” on page viii

● “Product Documentation” on page viii

● “Where to Find Documentation” on page ix

● “Conventions” on page xi

● “Additional Support” on page xii

Purpose
The Hyperion Analyzer Installation Guide explains product conventions, features, 
and options, and it contains the concepts, processes, procedures, formats, tasks, 
and examples that you need to install Hyperion Analyzer.

Audience
Although this guide is intended for system and application administrators 
responsible for installing, configuring, and maintaining Hyperion Analyzer, 
advanced users will also benefit from the procedures and conceptual information. 
■ viiHyperion Analyzer Installation Guide for Windows



Preface
Document Structure
This document contains the following information: 

● Chapter 1, “Hyperion Analyzer Overview,” introduces the Hyperion Analyzer 
product and the components of the application. The chapter also provides an 
overview of the architecture and the installation options you have. 

● Chapter 2, “Installing Hyperion Analyzer on Microsoft Windows,” lists the 
system requirements for the server, the stand-alone client, and the client as are 
the installation procedures to install Hyperion Analyzer in a Microsoft 
Windows operating environment.

● Chapter 3, “What’s Installed?,”examines the directory structure of Hyperion 
Analyzer to provide a descriptive overview of the directory contents. This 
facilitates locating configuration files, documentation, and application folders 
and files.

● Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” provides 
specific instruction on installing Hyperion Analyzer into an existing IBM 
WebSphere application server.

● Chapter 5, “Deploying Hyperion Analyzer to BEA WebLogic,” provides 
specific instruction on installing Hyperion Analyzer into an existing BEA 
WebLogic application server.

● Chapter 6, “Creating Repositories with Scripts,” contains the procedures to 
create the database repositories and the required tables in the databases for all 
supported RDBMS systems.

● Chapter 7, “Importing Hyperion Analyzer Sample Reports,” furnishes the 
procedures to import Hyperion Analyzer and API Toolkit sample reports 
through the Java Web Client. 

● Chapter 8, “Uninstalling Hyperion Analyzer,” contains the procedure to 
uninstall Hyperion Analyzer from your Windows operating system.

Product Documentation

Information Map
The Hyperion Analyzer Information Map lists and describes all Hyperion 
Analyzer documentation and its location. 
viii ■ Hyperion Analyzer Installation Guide for Windows



Preface
➤ To display the information map:

1. Perform one of the following:

● From the Hyperion Analyzer Launch Page, click the Information Map 
link.

● From a browser window, enter the following URL:
http://<server>/Help/en/InformationMap/information_map.htm

Getting Started
Hyperion Analyzer Getting Started gives an overview of Hyperion Analyzer, 
relates terminology central to multidimensional analysis, explains application 
fundamentals and graphical user interfaces, and leads you through the creation of 
your first report using the Hyperion Analyzer Java Web Client.

New Features
Hyperion Analyzer New Features describes all new features specific to this 
release.

Client Online Help

Java Web Client Online Help
The Hyperion Analyzer Java Web Client Online Help provides detailed 
information about navigation, report creation, and advanced Java Web Client 
topics.

HTML Web Client Online Help
The Hyperion Analyzer HTML Web Client Online Help provides detailed 
information about navigation, report creation, and the features specific to the 
HTML Web Client.

Where to Find Documentation
All Hyperion Analyzer documentation is accessible from the following locations:

● The HTML Information Map is located at:
■ ixHyperion Analyzer Installation Guide for Windows



Preface
http://<server>/Help/en/InformationMap/information_map.htm

● Online help is accessible from the user interface that it documents. Start the 
product and click the Help button or menu command.

● The Hyperion Solutions Web site is located at http://www.hyperion.com.

➤ To access the documentation from the Hyperion Solutions Web site:

1. Log on to http://www.hyperion.com.

2. Select Support from the menu bar.

3. Enter your username and password, and click Login. 

Note: If you do not have a username and password, click New User Registration on 
the left side of the login page to request them.

4. Select Order/Download Documentation.

5. From the Product list box, select Hyperion Analyzer.

6. From the Display list box, select Documentation, then click Submit. 

➤ To access the documentation from the Hyperion Download Center:

1. Log on to http://hyperion.subscribenet.com .

2. In the Login ID and Password text boxes, type your assigned login ID and 
password. Then click Login.

3. If you are a member on multiple Download Center accounts, select the account 
that you want to use for the current session.

4. From the Product List, select Hyperion Analyzer.

5. In the New Releases tab, select Hyperion Analyzer 6.5.
x ■ Hyperion Analyzer Installation Guide for Windows
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Preface
Conventions
The following table shows the conventions used in this document:

Table i: Conventions Used in This Document 

Item Meaning

Arrows indicate the beginning of a procedure consisting of 
sequential steps or a one-step procedure.

Brackets [] In examples, brackets indicate that the enclosed elements 
are optional.

Bold Bold in procedural steps highlights major interface 
elements.

CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the + sign.

Example text Courier font indicates that the material shown is a code or 
syntax example.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown in 
Courier italics.

ARBORPATH When you see the environment variable ARBORPATH in 
italics, substitute the value of ARBORPATH from your site.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

n, x Italic n stands for a variable number; italic x can stand for 
a variable number or an alphabet. These variables are 
sometimes found in formulas.

Ellipses (...) Ellipsis points indicate that text has been omitted from an 
example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.
■ xiHyperion Analyzer Installation Guide for Windows



Preface
Additional Support
In addition to providing documentation and online help, Hyperion offers the 
following support for product information.

How to Order Printed Documentation
To order printed documentation use one ofthe following methods: 

● Visit the Hyperion Solutions Web site at http://www.hyperion.com .

● In the United States, call Hyperion Solutions Customer Support at 
877-901-4975.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers.

Education Services
Hyperion offers a variety of training options, including instructor-led training, 
custom training, and eTraining. This education covers all Hyperion applications 
and technologies and is geared to administrators, end users, and information 
systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s 
diverse, global customers. Hyperion Authorized Training Centers are certified to 
deliver courses developed by Hyperion. Custom Education Services—training on 
the configured and tailored applications that employees use on the job—is another 
option to enhance user productivity and to ensure smooth day-to-day operations. 
A service called eTraining—including computer-based training, Web-based 

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning
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Preface
training, and interactive Virtual Classroom training—provides a cost-effective 
means of giving you a hands-on introduction to product features and functions. 
Computer-based training (CBT) and Web-based training (WBT) provide 
high-quality, self-paced training at the user’s convenience, regardless of location.

For more information about training, contact your Regional Education Manager 
or visit the Hyperion Solutions Web site at http://www.hyperion.com to see 
a list of all training classes. 

Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the 
return on investment in, Hyperion products. Experienced Hyperion consultants 
and Hyperion Alliance Partners assist organizations in tailoring solutions to their 
particular requirements, such as reporting, analysis, modeling, and planning. 
Specific services include implementation consulting, custom business solutions, 
data integration, and technical consulting. Additionally, Hyperion offers a variety 
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages and 
Reviews, and including the services offered by Alliance Partners, contact your 
local consulting services representative, or visit the Hyperion Solutions Web site 
at http://www.hyperion.com to see a list of all Hyperion Alliance Partners.

Technical Support
Hyperion provides Web-based and telephone support to ensure that clients resolve 
product issues quickly and accurately. This support is available for all Hyperion 
products at no additional cost to clients with a current maintenance agreement.

● For Web-based support, or to see complete information on 
available support options, visit the Hyperion Solutions Web site 
at http://www.hyperion.com.

● In the United States, call 877-901-4975 for Hyperion Solutions Customer 
Support.

● From outside the United States, including Canada, call Hyperion Solutions 
Customer Support at 203-703-3600. Clients who are not serviced by support 
from North America should call their local support centers. 
■ xiiiHyperion Analyzer Installation Guide for Windows

http://www.hyperion.com
http://www.hyperion.com
http://www.hyperion.com


Preface
Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value 
your opinions on this documentation and want to hear from you. Send us your 
comments by completing the survey available at http://www.hyperion.com.
xiv ■ Hyperion Analyzer Installation Guide for Windows
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Chapter
1
1
Hyperion Analyzer Insta
Hyperion Analyzer Overview
Hyperion Analyzer consists of the following components:

● Repository: A central storage location for Hyperion Analyzer system data, 
user IDs, user preferences, and report definitions in relational database tables.

● Hyperion Analyzer Analysis Server: A servlet-based Web application that 
resides within the J2EE application server. The Analysis Server facilitates the 
rendering of reports to either the HTML or Java clients and provides 
Web-based user management.

● Hyperion Analyzer Administration Tools: A client that provides a Java 
graphical interface for managing users, users groups, and database 
connections using a supported Web browser. It also provides access to several 
administration utilities.

● Hyperion Analyzer Java Web Client: A client that enables online analysis 
of data. You can design and format custom analysis applications without 
“coding.” Hyperion Analyzer is commonly used to conduct sales, key 
performance, and financial and forecasting analyses.

● Hyperion Analyzer Windows Client: A Java Web client interface and 
functionality delivered as a Java application for supported Microsoft 
Windows operating systems.

● Hyperion Analyzer HTML Web Client: An HTML thin client used by way 
of a supported Web browser. It is engineered for information consumers who 
do not require advanced design and content-creation capabilities.

● Hyperion Analyzer API Toolkit: A tool that developers can use to 
incorporate the Hyperion Analyzer Java Web Client look and feel and 
functionality into their own custom Web applications.
■ 15llation Guide for Windows



Architectural Overview
Hyperion Analyzer functionality is distributed across a multitiered architecture:

● Client tier

● Server tier

● Database tier

Figure 1: Architectural Diagram of Hyperion Analyzer Functionality
16 ■ Hyperion Analyzer Installation Guide for Windows
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The client tier comprises the three Web browser clients and the API Toolkit. All 
clients communicate with the rest of the Hyperion Analyzer system using 
Hypertext Transmission Protocol (HTTP).

The server tier includes the following components:

● The Web server

● The J2EE application server

● The Hyperion Analyzer Analysis Server

● Drivers and protocols for communicating with the database server layer

The database tier supports OLAP and relational databases, and the relational 
Hyperion Analyzer repository. Data source connectivity to Hyperion Finacial 
Management and Hyperion Planning is also available.

A supported Web server is required to present the Web page from which Web 
clients are launched, to deliver files containing Java components, and to transport 
images generated at run time. After clients are established, the Web server 
manages all client mid-tier HTTP communication.

Hyperion Analyzer runs inside a J2EE application server. The supported J2EE 
application server shares Hyperion Analyzer business logic, network traffic, 
application security for large numbers of concurrent users, and they provide load 
balancing and fault tolerance.

Through the installation process, Hyperion Analyzer is deployed into a J2EE 
application server, and Hyperion Analyzer tables are created on the RDBMS 
selected repository option. The system leverages a Web server to communicate 
with clients.
■ 17Hyperion Analyzer Installation Guide for Windows



Deployment Options
Hyperion Analyzer provides a great deal of flexibility in the way you can 
configure the system. Configuration options are determined by several factors. 
Among other considerations, the following list includes some possible 
considerations for making deployment decisions:

● Current hardware and software

● Future hardware and software upgrades

● Quantity of data

● The balance between ease of configuration and performance

In an effort to assist you in your decision-making, Hyperion recommends 
examining the following deployment options:

“Deployment Option 1” on page 19

“Deployment Option 2” on page 20

“Deployment Option 3” on page 20

“Deployment Option 4” on page 22

“Windows Stand-Alone Client Option” on page 22
18 ■ Hyperion Analyzer Installation Guide for Windows
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Deployment Option 1
The first deployment option supports medium to large configurations. In this 
instance, the Web server and application server are on the same computer and are 
separate from the RDBMS repository and data sources. This is the most typical and 
highly recommended configuration option. The separation of the components 
allows for high scalability, and each hardware component can be upgraded 
individually as needed.

Figure 2: Hyperion Analyzer Deployment Option 1
■ 19Hyperion Analyzer Installation Guide for Windows



Deployment Option 2
This configuration establishes the Web server, application server, and RDBMS 
repository on same computer and separate from the data sources. This 
configuration option is used for medium-size deployments.

Figure 3: Hyperion Analyzer Deployment Option 2

Deployment Option 3
The third option is intended to support a large enterprise system with an existing 
systemic structure that Hyperion Analyzer can integrate into and leverage. The 
Web server and application server are on separate computers, as are the RDBMS 
repository and data sources. This is the typical configuration option for an 
20 ■ Hyperion Analyzer Installation Guide for Windows
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enterprise with a centralized Web server farm. However, this configuration 
requires more in depth knowledge of Web server and application server 
configuration.

Figure 4: Hyperion Analyzer Deployment Option 3
■ 21Hyperion Analyzer Installation Guide for Windows



Deployment Option 4
The forth option is best utilized for a small deployment, testing and prototype 
situations. The Web server, application server, Essbase/Hyperion Financial 
Management and RDBMS Repository are all on the same server. This option is not 
recommended for high concurrent usage, unless the servers have multiple CPUs 
and maximized availability of RAM.

Figure 5: Hyperion Analyzer Deployment Option 4

Windows Stand-Alone Client Option
Included in each of the deployment options depicted previously, is the option of 
implementing a stand-alone client in the Windows operating environment. This 
option provides TCP/IP connectivity to the Hyperion Analyzer repository, 
RDBMS, and OLAP data sources without the use of a Web and application 
22 ■ Hyperion Analyzer Installation Guide for Windows



1

servers. The drawback to this option is the required JDBC drivers and Hyperion 
Essbase client. This adds to the complexity of the deployment over the simpler, 
html-based thin client and java applet.

Installation Options 
You can install Hyperion Analyzer using any of the following procedures:

● Microsoft Windows Installation: The setup.exe installation file is provided 
for those installing Hyperion Analyzer on Microsoft Windows operating 
systems. You have the option of installing to the Apache Tomcat 4.1.x 
application server, an existing Apache Tomcat 4.0.4 or later, IBM 
WebSphere, or BEA WebLogic application server. Refer to the Chapter 2, 
“Installing Hyperion Analyzer on Microsoft Windows,” section for more 
information.

● UNIX operating system: Hyperion provides setup_aix.sh, 
setup_hpux.sh, and setup_solaris.sh shell scripts for installing 
Hyperion Analyzer Analysis Server on either the IBM AIX, HP-UX, or Sun 
Solaris UNIX operating systems. Depending on the opertaing system you are 
using, you have the option of installing to the Apache Tomcat 4.1.x 
application server, an existing Apache Tomcat 4.0.4 or later, IBM WebSphere, 
or BEA WebLogic application server. See Hyperion Analyzer Installation 
Guide for UNIX for more information.

● Manual deployments to application servers: You can deploy Hyperion 
Analyzer manually to several application servers if you prefer not to use the 
provided application server. The following options are available:

– IBM WebSphere installation: You must manually deploy Hyperion 
Analyzer into a previously installed application server. See Chapter 4, 
“Deploying Hyperion Analyzer into IBM WebSphere” section for more 
information.

– BEA WebLogic installation: You must manually deploy Hyperion 
Analyzer into a previously installed application server. See Chapter 5, 
“Deploying Hyperion Analyzer to BEA WebLogic,” for more 
information.
■ 23Hyperion Analyzer Installation Guide for Windows
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2
2
Hyperion Analyzer Insta
Installing Hyperion Analyzer 
on Microsoft Windows
This chapter provides the information and procedures you must prepare for and 
complete an installation of Hyperion Analyzer on your server or client system. The 
following sections will assist you in the process:

● “System Requirements” on page 25

● “Before Installing Hyperion Analyzer” on page 29

● “Installation Summary” on page 32

● “Installing Hyperion Analyzer” on page 32

● “After Installing Hyperion Analyzer” on page 48

● “Starting the Hyperion Essbase OLAP Server” on page 53“Configuring 
Microsoft IIS Web Server” on page 56

System Requirements
This section outlines the prerequisites needed for installing Hyperion Analyzer on 
Microsoft Windows. Your installation must satisfy the following general and 
application-specific system requirements.

Server System Requirements
Table 2: Hyperion Analyzer Server System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 512 MB RAM

Disk Space 1 GB of processing space
■ 25llation Guide for Windows



Operating System One of the following Operating Systems:

• Microsoft Windows NT 4 with Service Pack 6a or

• Microsoft Windows 2000 with Service Pack 3

Web browser One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2 or 7.0

Java plug in 1.3.0_02 or 1.3.1_07

Spreadsheet 
add-ins

Microsoft Excel 97 (sp1 or 2),  2000 or XP

Peripherals • SVGA monitor, 800x600 resolution

• CD-ROM drive

Network 
connection

TCP/IP

Application 
servers

One of the following servers:

• Tomcat 4.0.4

• Tomcat 4.1.18 (full installation provided)

• IBM WebSphere 4.0.5 Advanced Edition, or Advanced 
Edition Single Server

• IBM WebSphere 5.0, Express, or Enterprise Edition

• BEA WebLogic 6.1.4 (Service Pack 3 is supported)

• BEA WebLogic 7.0

OLAP servers One of the following servers:

• Hyperion Essbase 6.2.4 or 6.5.4 

• IBM DB2 OLAP Server 7.1 (FixPak 11)

• IBM DB2 OLAP Server 8.1 (FixPak 2)

Relational data 
sources

Hyperion Financial Management 3.0.3 or 3.0.4

Hyperion Planning 3.3

Table 2: Hyperion Analyzer Server System Requirements(Continued)

Component Requirement
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Stand-Alone Client System Requirements

Relational servers One of the following servers:

• IBM DB2 7.2 Enterprise Personal Edition (full installation 
provided), JDBC 2.0

• IBM DB2 8.1 Enterprise Server Edition

• Microsoft SQL Server 2000, SP3, MS SQL Server JDBC 
drivers

• Oracle 8.1.7 or 9.2.1, Native JDBC drivers

• Teradata 4.1

Other • Applicable Hyperion Essbase Runtime client

• Adobe Acrobat Reader 5.0

Table 3: Hyperion Analyzer Stand-Alone Client System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 256 MB RAM

Disk space 25 MB

Operating system One of the following operating systems:

• Microsoft Windows NT 4.0, Service Pack 6a

• Microsoft Windows 2000, Service Pack 3

• Microsoft Windows XP

Web browser for 
Web client

One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2 or 7.0

Web browser for 
Java client

One of the following browsers:

• Microsoft Internet Explorer 4, 5, or 6

• Netscape Navigator 4.7, 6.1, or 6.2

Table 2: Hyperion Analyzer Server System Requirements(Continued)

Component Requirement
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Client System Requirements

Java plug in for 
Java client

Sun Java Plug-in 1.3.0_02 or 1.3.1_07

Note: Installed automatically on first use of Hyperion 
Analyzer.

Relational 
repositories

One of the following repositories:

• IBM DB2 7.2 Enterprise Personal Edition, JDBC 2.0

• IBM DB2 8.1 Enterprise Server Edition, JDBC 2.0

• Microsoft SQL Server 2000, SP3, MS SQL JDBC

• Oracle 8.1.7 or 9.2.1

Other • Applicable Hyperion Essbase Runtime client

Note: To access Hyperion Essbase, the corresponding 
Hyperion Essbase Runtime client must be installed with the 
J2EE Application Server.

• Adobe Acrobat Reader 5.0

Table 4: Hyperion Analyzer Client System Requirements

Component Requirement

Processor 450 MHz CPU

Memory 512 MB RAM

Disk space 25 MB

Operating system One of the following operating systems:

• Microsoft Windows NT 4.0, Service Pack 6a

• Microsoft Windows 2000, Service Pack 3

• Microsoft Windows XP

Web browser for 
Web client

One of the following browsers:

• Microsoft Internet Explorer 5.5 or 6.0

• Netscape Navigator 6.2 or 7.0

Table 3: Hyperion Analyzer Stand-Alone Client System Requirements(Continued)

Component Requirement
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Before Installing Hyperion Analyzer
Prior to installing Hyperion Analyzer, there are a number of prerequisite tasks and 
considerations to execute at least examine for applicability to your situation. The 
following sections cover this information:

● “Preinstallation Checklist” on page 29

● “RDBMS Considerations” on page 30

● “Backing Up an Existing Repository” on page 32

Preinstallation Checklist
Complete the following tasks that apply to your installation situation prior to 
installing Hyperion Analyzer:

● Ensure that the user logged on to the server is an Administrator with 
unrestricted privileges.

● Review the system requirements for your configuration and ensure 
compliance.

● If there is a previous release of Hyperion Analyzer on the system, create a 
backup of the Hyperion Analyzer repository. For more information see, 
“Backing Up an Existing Repository” on page 32.

● Verify the server names and pathnames. Do not use the name “localhost” to 
identify servers.

Web browser for 
Java client

One of the following browsers:

• Microsoft Internet Explorer 4, 5, or 6

• Netscape Navigator 4.7, 6.1, or 6.2

Java plug in for 
Java client

Sun Java Plug-in 1.3.0_02 or 1.3.1_07 

Note: Installed automatically on first use of Hyperion 
Analyzer.

Other Adobe Acrobat Reader 5.0

Table 4: Hyperion Analyzer Client System Requirements(Continued)

Component Requirement
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● Ensure the availability of usernames and passwords for your Hyperion 
Essbase OLAP server and your RDBMS. 

Note: The name “System” cannot be used for logon accounts. Duplicate logons 
and passwords cannot be used. Ensure that your unique logons do not exceed 
eight (8) characters in length.

● W If Hyperion Financial Management is the OLAP server of choice for your 
installation, ensure that the Hyperion Financial Management client is installed 
on the same computer as the application server.

● Ensure that the correct JDBC drivers are available for the RDBMS repository 
you are using.

● If a preinstalled Apache Tomcat application server is used, ensure that it is 
stopped.

● If a preinstalled RDBMS system is being used, ensure that the service is 
started.

RDBMS Considerations

IBM DB2 Version 7.2
When using IBM DB2 7.2 as the relational repository for Hyperion Analyzer, you 
must configure DB2 to use JDBC 2.0 drivers and ensure that the following 
repository types comply as required:

● Enterprise Personal Edition

● Enterprise Server Edition

➤ To configure the DB2 RDBMS to use JDBC 2.0 drivers:

1. Stop all database services.

2. Run usejdbc2.bat on the sqllib\java12 subdirectory.

Note: When configuring the JDBC drivers for IBM DB2 8.1, ensure that the 
db2jcc.jar file is in the same directory as the db2java.zip file.
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3. Restart all database services.

Note: When installing the Hyperion Analyzer repository on an existing DB2 
database, you must provide a username and the database information to complete 
the installation. The username given must have been previously assigned to the 
database.

Enterprise Server and Personal Edition

● Enter the case-sensitive database server name when specifying locations and 
paths. “Localhost” is not a recommended server name.

● Usernames are restricted to eight (8) characters or less.

IBM DB2 Enterprise Server Edition Only

● Ensure that usernames are granted connection privileges to the database.

● Ensure the database and a username are created prior to installation in order to 
create the RDBMS repository.

Microsoft SQL Server 2000
● You must download the correct JDBC drivers from 

http://msdn.microsoft.com/downloads/ before installing Hyperion 
Analyzer. You are prompted during installation to locate the JDBC drivers.

● Do not create the database or the logon prior to installation. The installation 
creates the logon inside the database during installation.

Oracle
● A Root logon is required for creating a tablespace in Oracle.

● Use the case-sensitive tablespace server name when specifying locations and 
paths. “Localhost” is not a recommended server name.

● Do not create the tablespace or the username prior to installation. The installer 
creates the both inside the database.
■ 31Hyperion Analyzer Installation Guide for Windows

http://msdn.microsoft.com/downloads/


Backing Up an Existing Repository
The database tables in the Hyperion Analyzer repository have been reorganized. 
During the installation, the tables are migrated to the new structure. Before 
begining the installation, you must back up your existing repository. As a result of 
the table changes, previous releases of Hyperion Analyzer repository do not work 
with this release of Hyperion Analyzer.

Installation Summary
To install Hyperion Analyzer successfully, you must complete the following tasks:

● Select an installation language.

● Select a usage mode and setup type.

● Review the terms of the license agreement.

● Select and configure the application server.

● Select and configure the RDBMS.

● Configure Hyperion Analyzer.

● Review the summary of the installation.

● Complete the installation.

● Configure the software for your system.

Installing Hyperion Analyzer
The following procedure guides you through the process of installing Hyperion 
Analyzer.

Note: During the installation of Hyperion Analyzer, progress through the windows by 
clicking the Previous or Next button. To exit the installation, click the Exit button.

➤ To install Hyperion Analyzer:

1. Take one of the following actions:

● If you have the Hyperion Analyzer CD, insert the CD in your CD-ROM 
drive.
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● If you downloaded the Hyperion Analyzer software from an FTP site or 
the Hyperion Download Center, take one of the following actions:

– Navigate to the directory where you downloaded the installation 
application and double-click setup.exe.

On the Windows desktop, click Start>Run and type the 
<drive>:\<path>\setup.exe, then click OK.Where <drive> and 
<path> are the location of the Hyperion Analyzer installation application.

The Select a Language window is displayed.

Figure 6: The Select Language Window

2. Select a language in which to display the installation wizard, then click Next.
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The Welcome window is displayed.

Figure 7: Hyperion Analyzer Installation Welcome Window

3. Click Next.
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The Usage Mode window is displayed.

Figure 8: Hyperion Analyzer Installation Usage Window

4. Select one of the following usage types:

● To install a trial version of Hyperion Analyzer, select Evaluation.

● To install a licensed version of Hyperion Analyzer, select Licensed and 
then enter a valid license key.

Note: Your license key is provided on the Hyperion Download Center at  
http://hyperion.subscribenet.com.

5. Click Next.
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The Setup Type window is displayed.

Figure 9: Hyperion Analyzer Installation Setup Type Window

6. Select one of the following setup types:

● To install the Windows Stand-Alone Client, select Windows Client. This 
installs the files necessary to access Hyperion Analyzer server installed on 
another computer via TCP/IP only.

● To install both the client and the server software, click Enterprise 
Edition. This installs Hyperion Analyzer within an application server for 
access via HTTP and TCP/IP.

7. Click Next.
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The License Agreement window is displayed.

Figure 10: Hyperion Analyzer Installation License Agreement Window

8. After reviewing the license agreement, select I Agree, then click Next.
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The Select Application Server Type window is displayed.

Note: If you selected Windows Client in step 6, go to step 12 on page 41. Selecting and 
configuring an Application Server is not included when installing the Windows Client.

Figure 11: Hyperion Analyzer Installation Select Application Server Type Window

9. Select one of the following application server options:

● Tomcat 4.1 – Installs Hyperion Analyzer to an existing Apache Tomcat 
4.1 application server.

– Optional: Select to Install Tomcat 4.1.18. If you do not yet have an 
application server installed, Apache Tomcat 4.1.18 and Hyperion 
Analyzer are installed as part of the “batteries included” option.

● Tomcat 4.0 – Installs Hyperion Analyzer to an existing Apache Tomcat 
4.0.4 application server.
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● IBM WebSphere 4 – Installs Hyperion Analyzer to an existing IBM 
WebSphere 4.0.5 application server.

● IBM WebSphere 5 – Installs Hyperion Analyzer to an existing IBM 
WebSphere 5 application server.

● WebLogic 6.1 – Installs Hyperion Analyzer to an existing BEA 
WebLogic 6.1 application server.

● WebLogic 7.0 – Installs Hyperion Analyzer to an existing BEA 
WebLogic 7.0 application server.

10. Select Next.

The Configure Application Server window is displayed, as shown in 
Figure 12. Three application servers, two versions of each, are supported by 
Hyperion Analyzer.

Figure 12: Configure Application Server: Apache Tomcat 4.1.x (Default)
■ 39Hyperion Analyzer Installation Guide for Windows



11. Based on the application server option you selected, provide the following 
settings:

Table 5: Application Server Configuration Settings

Application Server Settings

Apache Tomcat 4.1 1. From Web Server list, select Use Default or 
Microsoft Internet Information Services (IIS)

2. Enter an HTTP Port Address, 80 is the default.

3. Optional: Click Advanced to set Host Alias to a 
name that differs from the server name.

Apache Tomcat 4.1 or 
4.0 (preinstalled)

1. Enter a path to the Application Server Location, or 
browse to the root directory by clicking the ellipses 
(...) button.

2. Enter an HTTP Port Address; 80 is the default.

3. Optional: Click Advanced to set Host Alias to a 
name that differs from the server name.

IBM WebSphere 4 or 5 
(preinstalled)

1. Enter a path to the Application Server Location, or 
browse to the root directory by clicking the ellipses 
(...) button.

2. Enter the case-sensitive Node Name of the server on 
which you are installing Hyperion Analyzer.

3. Enter an HTTP Port Address; 80 is the default.

4. Enter the Installed Applications Path, or browse to 
the root directory by clicking the Ellipses (...) button.

5. Optional: Click Advanced to set Host Alias to a 
name that differs from the server name.

BEA WebLogic 6.1 or 
7.0 (preinstalled)

1. Enter a path to the Application Server Location, or 
browse to the root directory by clicking the Ellipses 
(...) button.

2. Enter the case-sensitive Node Name of the server on 
which you are installing Hyperion Analyzer.

3. Enter an HTTP Port Address; 80 is the default.

Optional: Click Advanced to set Host Alias to a 
name that differs from the server name.
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12. Click Next.

The Select RDBMS Repository Type window is displayed, as shown in 
Figure 13. You specify the relational database for your Hyperion Analyzer 
repository here. You also specify whether a database, the repository, or both 
are to be created.

Figure 13: Hyperion Analyzer Installation Select RDBMS Repository Type Window
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13. Select an RDBMS Repository Type and select one of the options listed in 
Table 6.

Note: As part of the “batteries included” option, if you do not have an Existing RDBMS, 
select Install DB2 7.2 Personal Edition, Hyperion Analyzer installs the RDBMS and 
creates a database and repository.

Based on Table 6, you can make a decision from the following examples:

● For a first time installation, select the “batteries included“ option, or 
Create Database/Tablespace and Create Repository.

● If you have already created the database, select Create Repository.

Table 6: Options for the Supported RDBMS

RDBMS Options

IBM DB2 7.2 Personal 
Edition

• Create Repository - creates only the repository in an 
existing RDBMS installation and database. 

• Create Database - creates both the database and 
repository in an existing RDBMS installation.

• Install DB2 7.2 Personal Edition - “batteries 
included” installation option installs the RDBMS and 
creates a database and repository tables.

IBM DB2 7.2 
Enterprise Sever Edition

Create Repository - creates only the repository in an 
existing database and RDBMS installation.

IBM DB2 8.1 
Enterprise Personal 
Edition

Create Repository - creates only the repository in an 
existing database and RDBMS installation.

Oracle 8.1.7 or 9i • Create Repository - creates only the repository in an 
existing database and RDBMS installation.

• Create Tablespace - creates both the tablespace and 
repository in an existing RDBMS installation.

Note: Root user permissions are required to create a 
tablespace in Oracle.

SQL Server 2000 • Create Repository - creates only the repository in an 
existing database and RDBMS installation.

• Create Database - creates both the database and 
repository in an existing RDBMS installation.
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● If you are upgrading, uncheck all options. The installer will upgrade your 
repository automatically.

14. Click Next.

The Configure RDBMS Repository window, for your RDBMS selection is 
displayed. 

15. Enter the following RDBMS specific connection information into the 
Configure RDBMS Repository window according to Table 7 through 
Table 10 on page 44.

Table 7: IBM DB2 Personal Edition Connection Information

Text Box Entry

Destination Folder The path to store IBM DB2 Personal Edition software.

DB2 Database Name The database application name. The default is 
ANALYZ65.

DB2 Administrator 
Name

The DB2 administrator’s username.

DB2 Administrator 
Password

The password for the DB2 administrator’s username.

Table 8: DB2 7.2 and 8.1 Connection Information

Text Box Entry

DB2 Server The explicit database server name. Using 
“localhost” is not recommended

DB2 Database Name The database application name. The default is 
ANALYZ65.

DB2 Administrator 
Name

The DB2 Administrator’s username.

DB2 Administrator 
Password

The password for the DB2 administrator’s username.
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Port The port number used for client-server communication; 
the default is 50000

JDBC Driver Path The path to the JDBC driver; the default filename is 
db2java.zip.

Table 9: Oracle Connection Information

Text Box Entry

Oracle Server The explicit database server name. Using 
“localhost” is not recommended.

Oracle SID The Oracle SID.

Oracle Tablespace Name The name of the Oracle tablespace.

Oracle Username The Root account username.

Oracle Password The password for the Root account username.

Port The port used for client-server communication.

JDBC Driver Path The path of the Oracle JDBC driver; the default 
filename is classes12.zip.

Table 10: SQL Server 2000 Connection Information

Text Box Entry

MSSQL Server The explicit database server name. Using 
“localhost” is not recommended.

SQL Server Database 
Name

Enter the database application name; the default 
database name is ANALYZ65.

SQL Server 
Administrator User Name

The username for the SQL Server Administrator.

SQL Server 
Administrator Password

The password for the SQL Server Administrator.

Table 8: DB2 7.2 and 8.1 Connection Information(Continued)

Text Box Entry
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16. Optional: To ensure the connection information is entered correctly, click 
Test Connection when installing Hyperion Analyzer to an existing RDBMS 
repository type.

At this point in the installation process you can specify the JDBC drivers for 
an RDBMS type to establish a drill-through connection with another, existing 
database. This second set of RDBMS type and JDBC driver selections that 
supports relational drill-through functionality is optional.

17. Take one of the following actions:

● If a drill-through connection is not required, proceed to step 19.

● If a drill-through connection is required, select an available RDBMS type:

– DB2 7.2 Fixpack 7 Enterprise

– DB2 8.1 Enterprise

– Oracle 8.17

– Oracle 9.2.7

– MS SQL Server 2000 SP3

– Teradata 4.1

A corresponding JDBC driver path field is displayed. 

18. Enter or browse to the path name of the JDBC driver. For example, the JDBC 
driver file name for Oracle is classes12.zip. 

19. Click Next.

The Configure Hyperion Analyzer window is displayed, as shown in 
Figure 14 on page 46.

JDBC Driver Path The path to the Microsoft SQL Server JDBC driver. 
The default filename is mssqlserver.jar.

Master Port (Advanced) The port number used for client-server 
communication; the default port number is 1433.

DB Port (Advanced) The port used for server to database communication; 
the default port number is 1433.

Table 10: SQL Server 2000 Connection Information(Continued)

Text Box Entry
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Completing the Windows installation of Hyperion Analyzer involves 
configuring the installation and reviewing the installation summary.

Figure 14: Hyperion Analyzer Installation Configure Hyperion Analyzer Window

20. Enter the appropiate information into the following fields:

● In the Destination Folder text box, enter the path where you want 
Hyperion Analyzer software to be installed. The default is: 
<drive>\hyperion\analyzer

● In the Servlet Engine Name text box, type the name of the Servlet 
Engine. The default is Analyzer6_Server.

● In the RDBMS Repository Username text box, enter the username of a 
valid RDBMS user with Administrator privileges.

● In the RDBMS Repository Password text box, enter the valid password 
for the username.

21. Click Next.
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The Installation Summary window is displayed. The summary provides a list 
of configuration selections you have made.

22. Review the summary and take one of the following actions:

● To make corrections in the installation configuration, click Back.

● If the configuration is correct, click Next.

Hyperion Analyzer is installed. When the installation is complete, the Setup 
Complete window is displayed. A checkbox is displayed to view the 
installation logfile only if there are installation errors.

Figure 15: Hyperion Analyzer Installation Setup Complete Window

Note: The default user and password are Administrator and password respectively. 
The default domain is Analyzer. The installation log file is located in the 
<Destination Folder>/hyasetup.<timestamp>.log, where 
<Destination Folder> is the directory where Hyperion Analyzer software is 
installed and <timestamp> is the date and time of installation.
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23. Click Next.

The Setup Complete window closes and the installation of Hyperion Analyzer 
for Windows is complete.

24. Reboot the computer for IBM WebShere application server installations only.

After Installing Hyperion Analyzer
Before launching Hyperion Analyzer, you must perform are described in the 
following topics applicable to your installation choices:

● “Deciding System Variable Setting Methods” on page 48

● “Setting and Sourcing PATH Variables” on page 49

● “Manual Deployment of WebSphere and WebLogic” on page 52

● “Configuring External and Application Security” on page 52

● “Starting the Hyperion Essbase OLAP Server” on page 53

● “Starting RDBMS Services” on page 53

● “Starting the Hyperion Analyzer Server” on page 53

Deciding System Variable Setting Methods
There is a great deal of flexibility in your Hyperion Analyzer installation choices. 
With that flexibility you will be required to make configuration decisions.  The 
following table provides a matrix of selecting how system variables are set or 
sourced and when this requires rebooting the server prior to starting the application 
server and using Hyperion Analyzer.

Table 11: Setting PATH Variables Matrix

Application 
Server

Installation 
Choice Manual Set Variables Reboot

Apache Tomcat Batteries 
Included

No No

IBM WebSphere preinstalled No Yes

Apache Tomcat preinstalled Set system variables.  See “Setting Variables for 
Existing Apache Tomcat” on page 49.

Yes
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Setting and Sourcing PATH Variables
The PATH variable needs to be set or sourced for your Windows system before 
starting the existing Apache Tomcat or BEA Weblogic application server and 
using Hyperion Analyzer. The PATH variable can be set using:

● The system control panel

● The startup script

Setting the PATH variable in the System Control Panel sets the variable when the 
computer is started and requires rebooting the computer.  Sourcing the variable 
with the application server startup script goes into affect only for the current 
application server session and does not require rebooting the computer. This 
provides flexibility in how setting the PATH variable is implemented.

Setting Variables for Existing Apache Tomcat

➤ To set the PATH variable using the System Control panel:

1. Open the Windows System Control Panel and click the Advanced tab.

2. Click the Environment Variables button

3. Edit the PATH system variable to include the following paths with semi-colon 
delimiters:
%ANALYZER_INSTALL_ROOT%/adm/bin/nt
%ANALYZER_INSTALL_ROOT%/common

4. Click OK to close the Environment Variables dialog box.

5. Click OK to close the System Control Panel.

Apache Tomcat preinstalled Source system variables. See “Sourcing Variables 
for Existing Apache Tomcat” on page 50.

No

BEA WebLogic preinstalled Set system variables. See “Setting the PATH 
Variables for BEA Weblogic” on page 50.

Yes

BEA WebLogic preinstalled Source system variables. See “Sourcing the PATH 
Variables for BEA WebLogic” on page 51.

No

Table 11: Setting PATH Variables Matrix(Continued)

Application 
Server

Installation 
Choice Manual Set Variables Reboot
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6. Reboot the computer.

CAUTION: You must reboot the computer after setting PATH variables for 
the variables to take effect and Hyperion Analyzer to operate properly.

Sourcing Variables for Existing Apache Tomcat

➤ To source the PATH variables for Apache Tomcat with the application server 
startup script:

1. Ensure that the application server is stopped.

2. Locate the Hyperion Analyzer startup.bat file in your application server 
installation. For example, in the batteries included installation of Apache 
Tomcat, the path is:
c:\hyperion\analyzer\appserver\bin

3. Edit the startup.bat file to includesetting the PATH variable:
“call %analyzerinstallroot%\analyzer_env.bat“

4. Save and Close the startup.bat file.

5. Right-click on the shortcut to Hyperion Analyzer found at Start>Hyperion 
Solutions>Hyperion Analyzer 6.5>Start Analyzer Server, and click 
Properties.

6. Edit the Target path from analyzer_statup.exe to startup.bat 
without modifying any other part of the path.

7. Click OK.

Setting the PATH Variables for BEA Weblogic
The PATH variable needs to be set for your Windows system before starting the 
application server and using Hyperion Analyzer. The PATH variable can be set 
using the System Control panel. This sets the variable when the computer is started 
and requires rebooting the computer.

➤ To set the PATH variable for BEA Weblogic using the System Control panel:

1. Open the Windows System Control Panel and click the Advanced tab.
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2. Click the Environment Variables button.

3. Edit the PATH system variable to include the following paths with semi-colon 
delimiters:
%ANALYZER_INSTALL_ROOT%/adm/bin/nt
%ANALYZER_INSTALL_ROOT%/common

4. Click OK to close the environment variables dialog.

5. Click OK to close the Control Panel.

6. Reboot the computer.

CAUTION: You must reboot the computer after setting PATH variables for 
the variables to take effect and Hyperion Analyzer to operate properly.

Sourcing the PATH Variables for BEA WebLogic
If BEA WebLogic is used as your application server, you can source the PATH 
variables in the startup script. This is accomplished by editing the 
startWebLogic.cmd file. There are several tasks accomplished by doing this:

● Setting the CLASSPATH variables for BEA WebLogic

● Configuring the JAVAHOME variables

● Calling the analyzer_env.bat file

When analyzer_env.bat file is called it creates connections to the Hyperion 
Analyzer repository, other JDBC connections, and sets path variables required to 
enable Hyperion Essbase connections. The following procedure guides you 
through the task of sourcing the system variables:

➤ To source system variables for BEA WebLogic with the application server startup 
script:

1. Ensure that the application server is not running.

2. Locate the startWebLogic.cmd file by navigating to the following path:

\<beainstall>\wlserver6.1\config\<domainname>\startWebLogic.cmd

3. Where <beainstall> is the path where BEA WebLogic is installed, and 
<domainname> is the name of the domain created in BEA WebLogic.
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4. Edit the file to reflect the following changes:

“set CLASSPATH=.;.\lib\weblogic_sp.jar;.\lib\weblogic.jar; 
%CLASSPATH%”

“”%JAVA_HOME%\bin\java” -hotspot -ms128m -mx256m -classpath 
“%CLASSPATH%”...”
“call %analyzerinstallroot%\analyzer_env.bat“

Where %analyzerinstallroot% is the root directory of where Hyperion 
Analyzer is installed. The default is c:\hyperion\analyzer

Note: The changes to the values -ms and -mx are the suggested minimum values.

5. Save and Close the startWebLogic.cmd file.

Manual Deployment of WebSphere and WebLogic
If an existing installation of IBM WebSphere or BEA WebLogic are selected as the 
application server to deploy Hyperion Analyzer into, some manual deployment 
configurations must be executed before continuing. The following chapters 
provide the procedures and information required to deploy manually to the 
application servers:

● Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere”

● Chapter 5, “Deploying Hyperion Analyzer to BEA WebLogic”

Configuring External and Application Security
Once Hyperion Analyzer has been installed, at any time you have the option of 
implementing one of several security methods. Security can be broken down into 
external authentication and internal authorization. Hyperion Analyzer provides the 
following options for implementing security:

● Analyzer Security (default)

● Essbase Security

● External Authentication

The default Hyperion Analyzer security configuration is application security. 
Without a valid username and password, which is contained in the Hyperion 
Analyzer repository, you are not authenticated as a user in Hyperion Analyzer.
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Although not required for Hyperion Analyzer to operate, it is advisable to 
implement an external authentication method for integrating with other Hyperion 
products. This is provided by utilizing existing Hyperion Essbase security or 
configuring an existing authentication method such as the following:

● Lightweight Directory Access Protocol (LDAP)

● Microsoft Windows NT LAN Manager (NTLM)

● Microsoft Active Directory (MSAD)

For more information on these security options see Chapter 4 “Managing Security 
Access” of the Hyperion Analyzer Administrator’s Guide.

Starting the Hyperion Essbase OLAP Server

➤ To start the Essbase OLAP server:

1. From the Windows desktop, click Start > Programs > Hyperion Solutions 
> Hyperion Essbase > Essbase OLAP Server.

2. Enter a valid password and press Enter.

Starting RDBMS Services

Starting IBM DB2 Enterprise Personal Edition
If you selected and installed IBM DB2 Enterprise Personal Edition as your 
repository, ensure that the following services are started:

● DB2 – DB2

● DB2 – DB2DAS00

● DB2 JDBC Applet Server

Starting the Hyperion Analyzer Server
Follow the instructions in your application server documentation to start 
application servers other than Apache Tomcat. If you selected Apache Tomcat as 
your application server, the next section provides starting and stopping procedures.
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Starting and Stopping the Tomcat Application Server
If you selected the Apache Tomcat application server during the installation 
process, you must start the server before launching Hyperion Analyzer and stop 
the server when your work is complete.

➤ To start the Apache Tomcat application server click Start > Programs > 
Hyperion Solutions > Hyperion Analyzer 6.5 > Start Analyzer Server.

➤ To stop the Apache Tomcat application server click Start > Programs > 
Hyperion Solutions > Hyperion Analyzer 6.5 > Stop Analyzer Server. 

Starting Hyperion Analyzer
Deploy the following Hyperion Analyzer launch page URL to your users:

http://<hostname>/Analyzer6_Server/index.html

➤ To start the Hyperion Analyzer Client:

1. Open a browser, enter the launch page URL, and press Enter.
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The Hyperion Analyzer Launch Page is displayed.

Figure 16: Hyperion Analyzer Launch Page

2. Select from the following list of options:

● Java Web Client

● HTML Web Client

● Administration Tools Client

● Analysis Server Console
■ 55Hyperion Analyzer Installation Guide for Windows



The selected option opens in a new browser window. The appropriate client 
starts and the Login page is displayed.

Note: If you do not have the correct Java console, you are prompted to permit it to 
be automatically installed.

3. Enter a valid User ID and Password, then click Login.

The Hyperion Analyzer option is displayed in the browser.

The Hyperion Analyzer Launch Page

The Hyperion Analyzer Launch Page is a great source of information and other 
Hyperion Analyzer resources. From the Launch Page you can:

● Link to Essbase.com

● Launch the Information Map

● See instructions on how to install a sample report group

● Access to the Hyperion Analyzer API Toolkit Jump Start Guide

● Launch a sample HTML Web Client

Configuring Microsoft IIS Web Server
When employing Microsoft Internet Information Services (IIS) in conjunction 
with the Apache Tomcat 4.0.4 application server, you must manually configure the 
Microsoft IIS Web server.

➤ To configure Microsoft IIS for Apache Tomcat:

1. Add a virtual directory called “jakarta” to the directory containing the 
isapi_redirect.dll (hyperion/analyzer/appserver/bin), and set 
permissions to read and execute.

2. Add an ISAPI filter called “jakarta” to the same directory.

3. Restart Microsoft IIS.
56 ■ Hyperion Analyzer Installation Guide for Windows



2

Manually Configuring Microsoft IIS Procedure

➤ To add a virtual directory and set permissions:

1. Run the Microsoft IIS Internet Service Manager, Click the plus sign (+) to 
expand the Web server name node, then select the Default Web site.

2. Right-click and select Properties.

The Default Web Site Properties dialog box is displayed.

3. Click the Directory Security tab.

4. In the Anonymous Access and Authentication Control section, click Edit.

The Authentication Methods dialog box is displayed.

5. Ensure that the Anonymous User is a valid Windows NT user with read, write 
or change privileges, then click OK.

6. Right-click the Default Web site again, and select New > Virtual Directory.

The Virtual Directory Creation dialog box is displayed.

7. Enter Jakarta as the virtual directory name, then click Next.

8. Enter the path to the directory containing the isapi_redirect.dll 
(hyperion/analyzer/appserver/bin), then click Next.

9. Ensure the Allow Read Access and Allow Execute Access checkboxes are 
selected, then click Finish.

The Virtual Directory is displayed in the tree below the Default Web site.

10. Select the Default Web site, then right-click and select Properties.

The Default Web Site Properties dialog box is displayed.

11. Click the ISAPI Filters tab, then click Add.

The Filter Properties dialog box is displayed.

12. Enter Jakarta as the filter name.

13. Enter the path to the directory containing the isapi_redirect.dll file 
(hyperion/analyzer/appserver/bin), then click OK.

14. Restart Microsoft IIS.
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Chapter
3
3
Hyperion Analyzer Insta
What’s Installed?
This chapter provides information about what is installed with Hyperion Analyzer 
and where it is located. Installation locations are based on the deployed application 
server. In general however, Hyperion Analyzer is structured as described in  the 
tables in the following sections.

Hyperion Analyzer Top-Level Directories
Where ever Hyperion Analyzer is installed on your system, the following table 
lists the directories under the top level of the \analyzer directory.

Table 12: Hyperion Analyzer Top-Level Directories

Directory Description

adm The directory containing Hyperion Analytical Data 
Model highest directory level (a Java API to Hyperion 
Essbase)

appserver The directory containing the application server installed 
with Hyperion Analyzer

common The directory containing the DLL used for 
implementing external authentication

conf The directory containing configuration files

css The directory containing JRE jar files for implementing 
external authentication

jdk The directory containing the Java SDK files

utils The directory containing the migration utilities for 
previous versions of Hyperion Analyzer
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Hyperion Analyzer Server Directories
If you have installed Apache Tomcat with Hyperion Analyzer the server 
directories are in the following directory path:
\hyperion\analyzer\appserver\webapps\Analyzer6_Server\

If you have installed Hyperion Analyzer in an existing Apache Tomcat installation 
the server directories are in the following directory path:
<tomcatinstallroot>\appserver\webapps\Analyzer6_Server\

If you installed Hyperion Analyzer into an existing Application server the 
directories are in the following directory path:
\hyperion\analyzer\

All of the Hyperion Analyzer files are contained in the Analyzer.ear file. See 
Chapter 4, “Deploying Hyperion Analyzer into IBM WebSphere,” or Chapter 5, 
“Deploying Hyperion Analyzer to BEA WebLogic,” for more information about 
deploying the EAR file.

The directory contains an \Ear subdirectory. This contains the contents of the 
EAR file. When changes are made to the deployment, they can be made to this 
directory. Then when it is time to redeploy the EAR file, you can rebuild it using 
the \analyzer\utils\rebuild_ear.bat file.

wp_output The directory used for Web publishing functions within 
Hyperion Analyzer for application servers other than 
Apache Tomcat

wp_templates The directory used for Web publishing templates within 
Hyperion Analyzer for application servers other than 
Apache Tomcat

Table 13: Hyperion Analyzer Server Directories

Directory Description

analyzer This directory is for later use by Hyperion Analyzer. 

Help This directory containing the documentation for 
Hyperion Analyzer

Table 12: Hyperion Analyzer Top-Level Directories(Continued)

Directory Description
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images This directory containing the graphics used by the 
launch page.

images_launch This directory contains 

logs This directory is for later use by Hyperion Analyzer.

samples This directory contains the .arg files for installing the 
Hyperion Analyzer sample report groups.

temp This directory is for later use by Hyperion Analyzer.

templates This directory contains report templates used by the 
Java Web Client.

templates_de This directory contains report templates used by the 
Java Web Client in German.

templates_fr This directory contains report templates used by the 
Java Web Client. in French.

templates_ja This directory contains report templates used by the 
Java Web Client. in Japanese.

templates_javalook This directory contains report templates used by the 
Java Web Client in an alternate look and feel.

templates_toggle This directory contains alternate report templates used 
by the Java Web Client.

WEB-INF This directory contains other application server 
configuration and library files.

wp_output This directory is used for Web publishing functions 
within Hyperion Analyzer. This directory is located 
here only for Apache Tomcat.

wp_templates This directory is used for Web publishing functions 
within Hyperion Analyzer. This directory is located 
here only for Apache Tomcat.

Table 13: Hyperion Analyzer Server Directories(Continued)

Directory Description
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4
Hyperion Analyzer Insta
Deploying Hyperion Analyzer 
into IBM WebSphere
If you are using IBM WebSphere, you must manually deploy Hyperion Analyzer 
into a previously installed IBM WebSphere application server. It is assumed that 
all system requirements have been met and that the Hyperion Analyzer installation 
has been executed, including the selection of IBM WebSphere as the application 
server.

Deploying to IBM WebSphere

Deploying to IBM WebSphere Advanced Edition
The following procedures are described for IBM WebSphere Advanced Edition. 
Those using IBM WebSphere Advanced Edition Single Server, should proceed to 
“Deploying to Advanced Edition Single Server” on page 66.

Installing the Web Application

➤ To install the Hyperion Analyzer Web application:

1. Copy the output Analyzer65.ear enterprise archive file from the location 
designated as the destination folder.

You have the option of placing a copy of the Analyzer65.ear in the 
WebSphere Installable Apps directory.

CAUTION: Do not place the archive file in the InstalledApps directory 
or Hyperion Analyzer is unable to start.
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2. Open the WebSphere Administration Server Console.

3. Right-click the Enterprise Applications node in the navigation window (on 
the left side of the console interface).

4. Select Install Enterprise Application.

Note: Leave the Application Name field blank on this window.

5. Click Browse, navigate to the Analyzer65.ear enterprise archive file 
located in the default Installable Apps directory, and open it.

6. Click Next.

Setting Up WebSphere Security
During the deployment process, you are prompted to set up WebSphere system 
security by the Mapping Users to Roles dialog box.

➤ To set up WebSphere security and define user permissions:

1. With the Everyone label selected, click the Mapping Users to Roles select 
button.

2. In the Select Users/Groups – Everyone dialog box, select the Everyone (No 
authentication) check box, then click OK.

WebSphere indicates that all Hyperion Analyzer users belong to a single 
security group, called Everyone. You can specify Hyperion Analyzer roles 
and permissions later, using Hyperion Analyzer Administration Tools.

3. Proceed through the next series of installation pages until you reach the 
Selecting Application Servers page. 

This window enables IBM WebSphere Enterprise Server Edition to specify 
the application servers in the network cluster supporting Hyperion Analyzer.

The Confirm the Following is the last page in the series. 

4. Ensure that the node, port, and the fully qualified pathname to the 
InstalledApps directory are displayed in the Confirm the Following page. 

These descriptions must be correct and match the information you provided to 
the Hyperion Analyzer installation exactly. If they do not, you have the option 
of reinstalling or modifying the web.xml configuration file manually.

5. Click Finish to complete installation of the enterprise application.
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Changing the IBM HTTP Server httpd.conf file

Note: This procedure is for Windows only.

➤ To change the httpd.conf file:

1. Use a text editor to open the IBM HTTP Server httpd.conf file. The default 
location is C:\IBM_HTTP_Server\Conf\httpd.conf.

2. Search for the following information:

AfpaEnable
AfpaCache on
AfpaLogFile “d:\IBM HTTP Server\logs\afpalog” V-ECLF

3. Comment out these three lines by entering a pound sign (#) at the beginning 
of each line, as follows:

# AfpaEnable
# AfpaCache on
# AfpaLogFile “d:\IBM HTTP Server\logs\afpalog” V-ECLF

Regenerating the Web Server Plug-in

➤ To regenerate the Web Server Plug-in:

1. Open the WebSphere 4 Administration Server Console.

2. Expand the Nodes node in the navigation window (at the left side of the 
console interface).

3. Right-click the server node where Hyperion Analyzer is installed.

4. Select Regen Webserver Plug-in.

5. Go to Microsoft Windows Services and stop and start the IBM HTTP Server.

6. Reboot the WebSphere server for the new environmental variables to take 
effect.

Start the Hyperion Analyzer Web Application

➤ To start the Hyperion Analyzer Web application:

1. Open the WebSphere Administration Server Console.
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2. Expand the Enterprise Application node in the navigation window (on the 
left side of the console interface).

3. Right-click the Hyperion Analyzer application.

4. Select Start.

5. Open a Web browser and enter the URL provided in the last window of the 
Hyperion Analyzer installation. The default URL is
http://Analyzer6_Server/index.html.

The Hyperion Analyzer launch page is displayed, and you can begin 
multidimensional and relational analysis with the Hyperion Analyzer client of 
your choice.

Deploying to Advanced Edition Single Server

Installing the Web Application

➤ To install the Hyperion Analyzer enterprise application:

1. Copy the output Analyzer65.ear enterprise archive file from the location 
designated as the destination directory. The default is 
C:\Hyperion\Analyzer.

You have the option of placing a copy of the archive in the WebSphere 
Installable Apps directory.

CAUTION: Do not place the archive file in the InstalledApps directory 
or Hyperion Analyzer is unable to start.

2. Open the WebSphere Administration Server Console.

3. Expand the Nodes node and the server node where Hyperion Analyzer is to be 
installed, then select Enterprise Application.

4. Click the Install button.

Note: Leave the Application Name field blank on this window.

5. Use the Browse button to navigate to the enterprise archive file; the default is 
the Installable Apps directory.
66 ■ Hyperion Analyzer Installation Guide for Windows



4

6. Click Next.

Set Up WebSphere Security
During the deployment process you are prompted to set up WebSphere system 
security. The WebSphere Application Installation Mapping Roles to Users page 
indicates that all Hyperion Analyzer users belong to a single security group, called 
Everyone.

➤ To set up WebSphere security and define user permissions:

1. In the Mapping Roles to Users page, select the Special Subjects Everyone 
check box.

You can specify Hyperion Analyzer roles and permissions later, using 
Hyperion Analyzer Administration Tools.

The Confirm the Following is the last page in the series. 

2. Ensure that the node, port, and the fully-qualified pathname to the 
InstalledApps directory are displayed in the Confirm the Following page.

These descriptions must be correct and match the information that you 
provided to the Hyperion Analyzer installation exactly. If they do not, you 
have the option of reinstalling or modifying the web.xml configuration file 
manually.

3. Click Finish to complete installation of the enterprise application.

Changing the IBM HTTP Server httpd.conf file

➤ To change the httpd.conf file:

1. Use a text editor to open the IBM HTTP Server httpd.conf file. Its default  
location is C:\IBM_HTTP_Server\Conf\httpd.conf.

2. Search for the following information:

AfpaEnable
AfpaCache on
AfpaLogFile “d:\IBM HTTP Server\logs\afpalog” V-ECLF

3. Comment out these three lines by entering a pound sign (#) at the beginning 
of each line as follows:
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# AfpaEnable
# AfpaCache on
# AfpaLogFile “d:\IBM HTTP Server\logs\afpalog” V-ECLF

Regenerating the Web Server Plug-in

➤ To regenerate the Web Server Plug-in:

1. Open the WebSphere 4 Administration Server Console.

2. Expand the Nodes node and the server node where Hyperion Analyzer is 
installed. Expand the Application Servers node, then click Default Server.

3. Under the Advanced Settings banner, click Web Server Plug-in 
Configuration.

4. Click the Generate button.

5. Go to Microsoft Windows Services and stop and start the IBM HTTP Server.

6. Reboot the WebSphere server for the new environmental variables to take 
effect.

Starting the Hyperion Analyzer Web Application

➤ To start the Hyperion Analyzer Web application:

1. Open the WebSphere Administration Server Console.

2. Locate and expand the Nodes node and the node where Hyperion Analyzer is 
installed. 

3. On the left side of the console interface, click the Enterprise Application 
node in the navigation page.

4. Select the new Web application item checkbox (Analyzer65).

5. Click the Start button.

6. For instructions on continuing with the installation by returning to the section; 
Configuring External and Application Security of the installation in Chapter 2.
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Hyperion Analyzer Insta
Deploying Hyperion Analyzer 
to BEA WebLogic
Deploying to BEA WebLogic 
You must manually deploy Hyperion Analyzer into a previously installed BEA 
WebLogic 6.1 or 7.0 application server.

➤ To manually deploy Hyperion Analyzer to a BEA WebLogic 7.0 application 
server:

1. Start the BEA WebLogic Server.

2. Start the WebLogic Server Console.

3. Navigate to Deployments>Applications, then click Configure a new 
Application.

Steps for deployment are displayed on this Web page. Under Step 2 a series 
of hyperlinks follows the “Listing of” text.

4. Click the correct drive and navigate to the newly created enterprise archive 
(EAR) file.

5. When the correct EAR file is displayed, click its corresponding [select] 
hyperlink.

Step 3 of the deployment process prompts you to indicate the server to which 
the EAR file is deployed.

6. Select an Available Server, and move it to the Target Server window using 
the arrow button control.

7. Enter a name for the Application in the Step 4 field, the default is 
“Analyzer65”.

8. Click the Configure and Display control button.

The WebLogic Server EAR file is configured and deployed.
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9. Continue with the installation by returning to the section; “Configuring 
External and Application Security” on page 52 of the installation in Chapter 2.
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Creating Repositories with 
Scripts
Database administrators might want to create repositories by running scripts rather 
than distributing their security information. All SQL scripts can be stored in one 
of the following locations:

● The SQLScripts.zip archive in the CD-ROM Repository subdirectory

● TEMP/_hya_tmp directory(after installation) 

Scripts can be run for each of the RDBMS types that Hyperion Analyzer supports. 
The following sections contain the procedures for creating repositories:

“Creating the Repository for IBM DB2” on page 71

“Creating the Repository for Oracle” on page 73

“Creating the Repository for SQL Server” on page 76

Creating the Repository for IBM DB2
There are three scripts for creating an IBM DB2 repository:

● AnalyzerCreateDatabaseDB2.sql creates an IBM DB2 7.2 Enterprise 
Server Edition database.

● AnalyzerCreateTablesDB2.sql creates all repository tables for both 
editions of DB2.

● AnalyzerDefaultDataDB2.sql populates tables with Hyperion Analyzer 
default configuration data (IBM DB2 7.2 Enterprise Server Edition).
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➤ To create an IBM DB2 repository:

1. Open the AnalyzerCreateDatabaseDB2.sql script in an SQL editor and 
modify the following parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

2. Save your modifications and run the SQL script.

3. Open the AnalyzerCreateTablesDB2.sql script in an SQL editor and 
modify the following parameters:

Table 14: AnalyzerCreateDatabaseDB2.sql Script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. 
Replace with ANALYZ65.

****DBNAME**** The Hyperion Analyzer database name. 
Replace with ANALYZ65.

****DB2USERNAME**** Replace with the user ID of the DB2 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding DB2 
Administrator's password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

Table 15: AnalyzerCreateTablesDB2.sql Script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ65.

****DBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ65.

****DB2USERNAME**** The user ID of the DB2 administrator. 
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4. Save your modifications and run the SQL script.

5. Open the AnalyzerCreateDatabaseDB2.sql script in an SQL editor and 
modify the following parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

6. Save your modifications and run the SQL script.

Creating the Repository for Oracle
There are four scripts for creating a Oracle repository:

● AnalyzerCreateDatabaseOracle8i.sql creates the Oracle database.

● AnalyzerCreateTablesOracle8i.sql creates the Hyperion Analyzer 
repository tables.

****DB2PASSWORD**** Replace with the corresponding DB2 
Administrator's password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

Table 16: AnalyzerCreateDatabaseDB2.sql script Parameters for IBM DB2

Parameter Description

****CAPSDBNAME**** The Hyperion Analyzer database name. Replace 
with ANALYZ65.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Table 15: AnalyzerCreateTablesDB2.sql Script Parameters for IBM 

Parameter Description
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● AnalyzerDefaultDataOracle8i.sql populates the tables with Hyperion 
Analyzer default configuration data.

● AnalyzerCreateRemoveOracle8i.sql is a script used internally by the 
create database script.

➤ To create an Oracle repository:

1. Open the AnalyzerCreateDatabaseOracle8i.sql script in a SQL editor 
and modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

2. Run the AnalyzerCreateDatabaseOracle8i.sql script.

Table 17: AnalyzerCreateDatabaseOracle8i.sql script Parameters for 
Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding Administrator's 
password.

****CAPSUSER**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.

****PASSWORD**** Replace with the corresponding CAPSUSER 
password.
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3. Open the AnalyzerCreateTablesOracle8i.sql script in a SQL editor 
and modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

4. Run the AnalyzerCreateTablesOracle8i.sql script.

5. Open the AnalyzerDefaultDataOracle8i.sql script in a SQL editor and 
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

6. Run the AnalyzerDefaultDataOracle8i.sql script.

Table 18: AnalyzerCreateTablesOracle8i.sql Script Parameters for 
Oracle

Parameter Description

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight 
(8) characters.

Table 19: AnalyzerDefaultDataOracle8i.sql Script Parameters for Oracle

Parameter Description

****DB2USERNAME**** Replace with the user ID of the Oracle 
Administrator. 

****DB2PASSWORD**** Replace with the corresponding Administrator's 
password.

****USERNAME**** Replace with an RDBMS repository username 
with which an administrator can access the 
database application.

Note: The username can have a maximum of 
eight (8) characters.
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Creating the Repository for SQL Server
There are four scripts for creating a SQL Server repository:

● AnalyzerCreateDatabaseMSSQL.sql creates the SQL Server database.

● AnalyzerCreateTablesMSSQL.sql creates the Hyperion Analyzer 
repository tables.

● AnalyzerDefaultDataMSSQL.sql populates the tables with Hyperion 
Analyzer default configuration data.

● AnalyzerRemoveDatabasesMSSQL.sql is a script used internally by the 
create database script.

➤ To create an SQL Server repository:

1. Open the AnalyzerCreateDatabase.sql script in a SQL editor and 
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

2. Run the AnalyzerCreateDatabaseMSSQL.sql script.

Table 20: AnalyzerCreateDatabase.sql Script Parameters for SQL Server

Parameter Description

****DBNAME**** The Hyperion Analyzer database name. Replace with 
ANALYZ65.

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight 
(8) characters.

****PASSWORD**** Replace with the corresponding USERNAME 
password.
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3. Open the AnalyzerCreateTablesMSSQL.sql script in a SQL editor and 
modify the following script parameters:

Note: Administrators do not need to modify the SQL if they use the SQL scripts 
generated by the installation. See TEMP/_hya_tmp.

4. Select the correct database from the query analyzer tool drop-down list box.

5. Run the AnalyzerCreateTablesMSSQL.sql script.

6. Run the AnalyzerDefaultDataMSSQL.sql script.

Table 21: AnalyzerCreateTablesMSSQL.sql Script Parameters for SQL 
Server

Parameter Replace With

****USERNAME**** Replace with an RDBMS repository username with 
which an administrator can access the database 
application.

Note: The username can have a maximum of eight (8) 
characters.
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Importing Hyperion Analyzer 
Sample Reports
7

Hyperion Analyzer provides sample reports contained in two report groups for you 
to import into your Hyperion Analyzer repository based on the Hyperion Essbase 
sample application:cube called Sample:Basic. The following topics describe how 
to import the Sample Reports and the API Samples report groups:

● “Creating a Database Connection” on page 79

● “Importing the Sample Report Group” on page 80

● “Importing the API Samples Report Group” on page 81

The procedures assume the following conditions:

● Hyperion Analyzer is installed.

● A valid Essbase OLAP server has been started.

● A valid application server has been started.

Importing Sample Reports

Creating a Database Connection
 It is necessary to create a database connection to the Hyperion Essbase cube 
before importing the sample reports.

➤ To import the sample report group and reports:

1. Start Hyperion Analyzer Java Web client.

2. Start a supported Web browser.

3. Select File > Open.
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4. Enter the URL of the Hyperion Analyzer launch page (as copied from the last 
installation window), and press Enter.

For example:

http://<servername>/ Analyzer6_Server/webapp/Analyzer6/index.html

5. On the Hyperion Analyzer Launch Page, click the Java Web Client link.

The Login page is displayed.

6. Enter a valid user ID and password (Administrator/password) and click OK.

7. In Hyperion Analyzer, select Tools > User Preferences from the drop-down 
menu.

The User Preferences dialog box is displayed.

8. Click the Connections screen name in the navigation window.

The Connections User Preferences tab is displayed.

9. Click the Add New button.

The Select Database Type dialog box is displayed.

10. Select Hyperion Essbase from the drop-down list and click OK.

The Hyperion Essbase Login dialog box is displayed.

11. Specify the Hyperion Essbase server, and a valid Hyperion Essbase user ID 
and password, then click OK.

The List Databases dialog box is displayed.

12. Select Sample:Basic from the Available Databases list and click the 
right-arrow (>) button.

Sample:Basic is added to the Selected Databases list.

13. Click OK.

Sample:Basic is added to the Connections User Preferences list.

14. Click Apply, then click Close.

Importing the Sample Report Group
It is necessary to import a report group by using the Java Web Client.

Note: You must be and Administrator or Power User and have write privileges to import 
a report group.
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➤ To import a sample report group:

1. From the Java Web Client Menu Bar select File | Import | Report Group.

The Open dialog box is displayed.

2. Select the Sample Reports.ARG file located in the following directory:

Hyperion\analyzer\appserver\webapps\Analyzer6_Server\samples

The Map Connections dialog box is displayed.

3. Select localhost:Sample:Basic from the Exported Connection list, then 
select the database connection that you just created in the Available Database 
Connections list.

4. Click the Map It! button.

5. Click OK.

6. Type Sample Reports for the report group name and click OK.

The report group is saved to the repository.

Importing the API Samples Report Group

➤ To import the API Samples report group:

1. From the Java Web Client Menu Bar select File | Import | Report Group.

The Open dialog box is displayed.

2. Select the api_samples.ARG file located in the following directory:

Hyperion\appserver\hosts\default_host\Analyzer6_Server\
Analyzer6\web\samples

The Map Connections dialog box is displayed.

3. Select localhost:Sample:Basic from the Exported Connection list, and then 
select the database connection you just created from the Available Database 
Connections list.

4. Click the Map It! button.

5. Click OK.

6. Type API Samples for the report group name and click OK.

The API Samples report group is saved to the repository.
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Uninstalling Hyperion 
Analyzer
Uninstalling Hyperion Analyzer from Windows

➤ To remove a Microsoft Windows installation of Hyperion Analyzer:

1. Perform one of the following:

● If you installed IBM DB2, unininstall it by performing the following:

– Click Start>Settings>Control Panel>Administrative 
Tools>Services.

– Stop all DB2 services and return to the Control panel.

– Double-click Add Remove Programs. If you installed IBM DB2 
Personal Edition, for the purposes of the release, uninstall the 
following application:
IBM DB2

Note: This procedure assumes that you installed Hyperion Analyzer to the default 
location. If you installed Hyperion Analyzer to an alternate location, ensure that the 
\analyzer directory and all of its contents are removed.

● Delete the following directory: C:\Hyperion\analyzer

Hyperion Analyzer has been removed from your system. 
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